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Зачастую значения, вычисленные вручную, не обеспечивают оптимальных характеристик, 
и нам необходимо изменить параметры компонентов. Это можно сделать двумя способами: 
подстройкой либо оптимизацией.

Что такое подстройка?

Подстройка – это способ, при котором производится изменение параметров компонентов 
и затем наблюдается воздействие этого изменения на характеристики схемы. Это способ 
вручную добиться требуемых характеристик от схемы, которая в ряде случаев работает 
правильно.

Что такое оптимизация?

Оптимизация – автоматизированная процедура получения требуемых характеристик 
схемы, в рамках которой система ADS может модифицировать параметры компонентов 
схемы для достижения конкретных целей оптимизации. Следует обратить особое 
внимание на задание целей – они должны быть реально достижимыми, в противном 
случае получить результат будет невозможно. Кроме того, оптимизируемые параметры 
компонентов должны находиться в реализуемых на практике пределах, и эти пределы 
должны устанавливаться разработчиками с учетом практических ограничений.

Рис. 13.



03 | Keysight | Подстройка и оптимизация – Руководство с демонстрационными примерами

Выполнение подстройки в системе ADS

На данном шаге рассматривается функция подстройки в системе ADS, которая дает 
пользователю возможность регулировать значения параметров и видеть результаты 
симуляции на дисплее данных в реальном времени. Чтобы выполнить подстройку, 
вы сначала выбираете функцию подстройки, а затем – подстраиваемый компонент. 
Рассмотрим пример – схему фильтра нижних частот, которую мы спроектировали в 
разделе «Начало работы с системой проектирования Advanced Design System (ADS)», и 
подстроим параметры компонентов с целью улучшения характеристик схемы.

1. Откройте электрическую принципиальную схему фильтра нижних частот. Если вам 
нужна помощь в создании этой схемы, вы можете загрузить раздел «Начало работы 
с системой проектирования Advanced Design System (ADS)» данного руководства. 

Удалите или деактивируйте с помощью иконки  компонент Display Template 

(Шаблон вывода данных)  и компонент симуляции . 

2. На дисплее данных удалите все графики и вставьте новый график в прямоугольной 
системе координат (rectangular plot), как показано на рисунке ниже.

3. Нажмите мышью на страницу дисплея данных, выберите S(1,1) и S(2,1) 
из всплывающего окна, нажмите мышью кнопку Add>> (Добавить) и при 
соответствующем запросе выберите в качестве единиц измерения dB (дБ).

Рис. 14.

Рис. 15.
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4. Нажмите кнопку OK, чтобы изображение на дисплее данных соответствовало 
показанному ниже.

5. Разместите окна Tune Parameters (Параметры подстройки) и Schematic 
(Электрическая принципиальная схема) бок о бок. Запустите функцию подстройки, 
нажав мышью иконку Tuning (Подстройка) .

6. Подстройка управляет симулятором, вследствие чего контроллер симуляции 
необходим в любом случае. При открытом окне Tune Parameters (Параметры 
подстройки) выбирайте в окне схемы фильтра нижних частот один за другим 
конденсаторы и индуктивности и добавляйте их в параметры подстройки. 
После каждого выбора вы будете видеть маленькое окно, как показано на 
рисунке. Отметьте компонент и нажмите кнопку OK для подстройки. Чтобы иметь 
подходящий диапазон для подстройки параметров компонентов, измените у всех 
компонентов максимальные значения на 150.

Рис. 16.

Рис. 17.
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7. Начните перемещать ползунок параметра компонента, изменяя его значение, и 
наблюдайте соответствующее изменение графика.

Рис. 18.

Обратите внимание, что у Мастера подстройки существует множество других функций:

 a. Можно сохранять временные состояния подстройки, нажимая мышью иконку Store 
(Сохранить). Это дает возможность записывать промежуточные состояния при 
подстройке и возвращаться обратно к любому из сохраненных состояний с помощью 
нажатия мышью кнопки Recall (Вернуть). Такие состояния пропадают с закрытием 
Мастера. Результатом каждого сохраненного состояния является зафиксированная 
кривая в окне графика.

 b. Можно выбрать опцию Snap Slider to Step (Привязать ползунок к шагу), после чего 
изменения положения ползунка будут происходить дискретно в соответствии с 
конечным размером шага, заданным в поле Step (Шаг) под ползунком.

 c. Значения параметров могут развертываться в линейном (Linear) или 
логарифмическом (Log) формате.

 d. Можно разрешать/запрещать подстройку параметра, нажимая мышью кнопку 
Enable/Disable (Разрешить/Запретить).

 e. Если сохранено много промежуточных состояний, то в целях улучшения 
различимости изображения можно включать/выключать отдельные графики.

8. Достигнув желаемых или наилучших из реально достижимых результатов, можно 
обновить параметры электрической принципиальной схемы в соответствии с 
произведенной подстройкой, нажав мышью кнопку Update Schematic (Обновить 
схему). Если вы случайно нажмете кнопку Close (Закрыть), появится всплывающее 
окно с запросом, желаете ли вы обновить свою схему или отказываетесь от 
обновления параметров.

9. После завершения подстройки нажмите мышью кнопку Close (Закрыть) и 
просмотрите в окне схемы и на дисплее данных значения параметров компонентов, 
полученные для отрегулированного отклика схемы.
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Выполнение оптимизации в системе ADS

Теперь давайте посмотрим, как можно выполнить оптимизацию данной схемы фильтра 
нижних частот, чтобы получить желаемые характеристики без необходимости 
проделывать работу вручную.
 
Оптимизация в системе ADS выполняется за три шага:

1. Задание целей оптимизации.
2. Размещение контроллера оптимизации, выбор типа оптимизации и количества 

итераций.
3. Подготовка параметров компонентов к оптимизации.

Сделаем копию подстраиваемой ячейки схемы, чтобы можно было провести оптимизацию 
той же самой электрической схемы и затем сравнить отклики схем – подстроенной 
вручную и оптимизированной системой ADS.

1. Перейдите в главное окно системы ADS, нажмите правой кнопкой мыши на 
копируемую ячейку и выполните команду Copy Cell (Копировать ячейку).

Рис. 19.



07 | Keysight | Подстройка и оптимизация – Руководство с демонстрационными примерами

2. Появится новое всплывающее окно, где можно дать скопированной ячейки 
новое имя. Давайте назовем ее DiscreteLPF_Opt. Обратите внимание на то, что 
если у копируемой ячейки есть иерархически связанные элементы, то следует 
использовать опцию Include Hierarchy… (Включить иерархические элементы), а если 
в нашей рабочей среде присутствуют папки, то можно скопировать данную ячейку 
в конкретную папку, нажав мышью кнопку Choose Folder (Выбрать папку). После 
завершения указанных выше действий нажмите мышью кнопку OK.

3. Вернитесь в главное окно и обратите внимание на то, что ячейка теперь скопирована 
и появилась в списке с новым именем, которые мы дали ей в процессе копирования.

4. Откройте вид электрической схемы этой новой скопированной ячейки.

Рис. 20.

Рис. 21.
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Задание целей оптимизации

1. Перейдите в палитру Opt/Stat/DOE (Оптимизация/Статистика/Планирование 
эксперимента) и поместите в схему компонент Goal (Цель), как показано здесь.

2. Два раза нажмите мышью компонент Goal (Цель) и введите параметры следующим 
образом:

a. Expression (Выражение) аналогично параметру по оси Y графика. В нашем случае мы 
используем dB(S(1,1)).

b.   Analysis (Анализ) совпадает с контроллером S-параметров в схеме. В нашем случае 
мы назовем этот параметр SP1.

c.   Нажмите мышью кнопку Edit (Редактировать) перед Independent Var (Независимая 
переменная); в появившемся окне нажмите мышью Add Variable (Добавить 
переменную) и введите freq в качестве имени переменной. freq – ключевое слово, 
обозначающее частоту (frequency) – этот параметр откладывается по оси X нашего 
графика, для которого мы определяем цели оптимизации.

d.  Выберите «меньше» (<) в поле Limits->Type (Предел->Тип) и введите –20.

Рис. 22.
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3. Разместите другую цель. Давайте зададим в качестве оптимизируемого параметра 
dB(S(2,1)), т.е. коэффициент передачи.

a. Повторите шаги аналогично заданию цели S(1,1) за исключением того, что мы также 
можем нажать мышью кнопку Add limit (Добавить предел), чтобы задать критерий 
полосы заграждения.

b.  В первом пределе (limit1) задайте критерий полосы пропускания: >-1 от 
минимальной частоты freq min = 0.01G (0,01 ГГц) до максимальной частоты freq max = 
0.2G (0,2 ГГц).

c.   Во втором пределе (limit2) задайте тип (Type) «меньше» (<)-30 от минимальной 
частоты freq min = 0.4G (0,4 ГГц) до максимальной частоты freq max = 1G (1 ГГц). (Не 
следует задавать максимальную частоту симуляции выше значения, заданного в 
контроллере S-параметров).

d. Если этого требует отклик схемы, мы можем добавить больше пределов – например, 
для типичного полосового фильтра у нас будет три предела для параметра S(2,1): 
первый для нижней границы полосы заграждения, второй для верхней границы 
полосы заграждения и третий для основной полосы пропускания.

e. После завершения ввода значений окно цели S(2,1) будет выглядеть, как показано 
ниже.

Рис. 23.

Рис. 24.
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Настройка контроллера оптимизации
 
a. Разместите на электрической схеме контроллер оптимизации из палитры 

библиотеки Opt/Stat/DOE (Оптимизация/Статистика/Планирование эксперимента), 
как показано ниже. 

b.   Дважды нажмите мышью на контроллер оптимизации и задайте следующие 
параметры: 
 a.  Optimization Type (Тип оптимизации) = Gradient (Градиент) 
 b.  Number of Iterations (Количество итераций) = 2000

c.   Перейдите на вкладку Display (Отображение) и выберите Clear All (Очистить все) – 
это снимет выбор всех опций.

d. Чтобы мы видели в схеме для данного компонента только требуемые опции, 
выберите опции Optim Type (Тип оптимизации) и Max. Iteration (Максимальное 
количество итераций).

e. Нажмите мышью кнопку OK, после чего схема должна принять показанный ниже 
вид.

Рис. 25.
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Задание оптимизируемых параметров компонентов
Последний шаг, который нам осталось выполнить перед запуском оптимизации – это 
подготовить к оптимизации параметры компонентов, значения которых система ADS затем 
будет изменять в процессе оптимизации.

1. Перейдите в меню Simulate->Simulation Variables Setup (Симуляция-> 
Настройка переменных симуляции).

Рис. 26.
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2.  В окне настройки переменных нажмите мышью вкладку Optimization (Оптимизация). 
Данное окно – единое место, где задаются подстраиваемые либо оптимизируемые 
компоненты, а также назначаются допуски на эти компоненты для проведения 
статистических анализов.

Отметьте для выполнения оптимизации все компоненты “L” и “C” (столбец Optimize) 
и задайте их минимальные (Min) и максимальные (Max) значения по собственному 
усмотрению (убедитесь при этом в реалистичности диапазонов значений). При задании 
этих диапазонов мы можем выбирать и другие форматы (столбец Format). Нажмите мышью 
кнопку OK.

Рис. 27.



13 | Keysight | Подстройка и оптимизация – Руководство с демонстрационными примерами

Оптимизация проекта

1. Нажмите мышью кнопку Optimize (Оптимизировать)  на панели инструментов 
электрической схемы – она располагается рядом с иконкой Tuning (Подстройка).

2. Откроется окно Панели оптимизации (Optimization Cockpit), где мы можем 
наблюдать процесс оптимизации схемы и соответствующего изменения параметров 
компонентов, достигая тем самым требуемых целей, которые мы задали в 
электрической схеме. Для выполнения данной задачи оптимизации потребовалось 
27 итераций (в вашем случае количество итераций может быть другим, так как это 
зависит от отклика на конкретное состояние вашей схемы, в котором вы запустили 
процесс оптимизации). Процесс останавливается по достижении либо заявленных 
целей, либо предельного количества итераций. Если мы добрались до предела 
итераций, не достигнув целей оптимизации, следует проверить приведенные ниже 
обстоятельства:

a. Реально ли достижимы цели на практике?
b. Не находимся ли мы вблизи минимальных или максимальных значений параметров 

компонентов?
c. Если мы подошли к предельным значениям параметров компонентов (минимальным 

либо максимальным), то можно нажать мышью кнопку Edit variable (Редактировать 
переменную) и, если это возможно, изменить предельные значения.

d. Можно увеличить количество итераций, нажав мышью кнопку Edit Algorithm 
(Редактировать алгоритм).

e. Можно изменить настройки целей оптимизации, нажав мышью кнопку Edit goals 
(Редактировать цели).

На панели оптимизации находится множество полезных элементов управления: мы можем 
временно приостанавливать оптимизацию, подстраивать сами значения параметров и 
редактировать цели в реальном времени.

3. Нажмите мышью кнопку Close (Закрыть) и, когда будет предложено, выберите 
опцию Update the Design (Обновить проект).

4. Выведите график параметров S11 и S21 на дисплей данных, добавив эти 
переменные на график в прямоугольной системе координат из панели инструментов 
Palette (Палитра), как это было продемонстрировано в Разделе 1, и проверьте, как 
полученные характеристики схемы соотносятся с нашими изначальными целями. 
Чтобы получить подробную информацию, на кривых можно расположить маркеры. 
Это можно сделать, либо используя панель инструментов Marker (Маркер) на 
дисплее данных, либо перейдя в меню Marker, как это показано на рисунке ниже на 
примере маркера m1.

Рис. 28.
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Панель инструментов Marker (Маркер): 

5. Сохраните всю сделанную работу, выполнив команду File > Save All (Файл > 
Сохранить все) в главном окне системы ADS.

Рис. 29.
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Примечание:
Настройки Целей оптимизации (Optimization Goals), включая сами цели и 
Контроллер (Controller), можно поместить на новую пустую электрическую 
схему и затем сохранить в качестве своего собственного шаблона. В окне 
схемы выполните команду File -> Save Design as Template (Файл -> Сохранить 
проект как шаблон). Это избавит от необходимости повторно выполнять 
данные настройки в будущих разработках.

Такой шаблон можно вставлять в любые новые проекты в любых рабочих 
средах с помощью команды Insert > Template (Вставить > Шаблон) с 
последующим выбором ранее сохраненного шаблона.

Помните, что переменные оптимизации в каждом проекте уникальны, и 
по этой причине мы должны переопределять параметры компонентов и 
их предельные значения до запуска каждой новой оптимизации схемного 
решения.

Также имейте в виду, что достижение желаемых характеристик может 
потребовать внесения изменений в цели и технические требования.

Примечание: Каждую отдельную настройку можно сохранить в качестве шаблона для 
последующего использования в системе ADS. В этот шаблон может включаться и дисплей 
данных – его можно вставить на странице дисплея данных с помощью опции Insert > 
Template (Вставить > Шаблон).

Поздравляем! Вы завершили раздел «Подстройка и оптимизация». 
Дополнительные примеры вы найдете здесь: 
www.Keysight.com/find/eesof-ads-rfmw-examples

Рис. 30.

http://www.Keysight.com/find/eesof-ads-rfmw-examples
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